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eASCTrend 6.0 EODS
ABLESYS CORPORATION
20954 Corsair Blvd.
Hayward, CA 94545
Phone: 510 265-1883
Fax: 510 265-1993
Email: ablesys1@ablesys.com
Internet: http://www.ablesys.com
Product: Automated end-of-day
trading software
Requirements: Minimum: 200 MHz
CPU, 128 MB RAM, 10 MB free hard
disk space, 56K modem and Internet
account, Windows 95/98/NT/2000/XP.
Suggested: WinXP or Win2000 with
2.4 GHz CPU or above, 512 MB RAM or
more, 40 GB hard disk, cable modem or
DSL Internet account. Access to AbleSys
EOD data (index, stock and mutual fund)
or you may use eSignal EOD data.
Price: $88/month trial; $595/year

by David Penn
don’t care how many pictures
of traders with their well-shod
feet propped up on mahogany
Herman Miller desks we must
be subjected to. The fact of the
matter is that trading is hard work and
there are only two ways that the average trader who dreams of success can
make money while looking anything
like the Masters of Trading Serenity
and Bliss that populate advertisements
in financial magazines. The first is to
get somebody else to do your trading
for you. The second is to get something
else to do your trading for you.
In the world of the latter, there are as
many rogues as there are righteous ones,
and scanning through trader message
boards for the conventional wisdom on
automated trading systems tends to produce more disgruntlement than gratitude. Unfortunately, it is often difficult
to determine where the fault lies—in
nefarious software that fails to perform
as advertised, or in clumsy, faint-hearted

I

traders unable to stomach the drawdowns and underperformance streaks
that are inevitable with even the most
effective mechanical trading systems.
Mechanical trading systems, it should
be said, aren’t simply for those who
don’t want to get their hands dirty. The
best mechanical trading systems still
have quite a bit of work for the trader
who wants to get the most out of his
system. Backtesting, parameter optimizing, scanning … all of these are just a
few of the tasks that the mechanical
trader will need to do in order to ensure
that the mechanical system being used
will perform as well as expected.
To this end, the mechanical trader
needs not just a system that will provide
winning trades with frequency, consistency, and regularity (that is to say,
“holding periods”), but also a system
that is responsive to the sort of tweaking
all traders do as the system and the
(wo)man trading the system get to know
each other better. This is one area where
AbleSys’ eASCTrend—known as the
first universal mechanical trading system for retail and small institutional
traders—excels, and one of the reasons
why you should get to know eASCTrend
6.0 EODS if you think mechanical trading might be for you.

INTRODUCING EODS
eASCTrend 6.0 EODS (EODS) is the
company’s latest iteration of
eASCTrend geared specifically for traders who trade stocks on an end-of-day
basis. Whereas eASCTrend 6.0 (which
I reviewed a few years ago for Technical Analysis of STOCKS & COMMODITIES) was and remains a highly regarded real-time product for stock, futures, and options traders, this new
version makes it possible for an entire
class of stock traders to consider managing all or part of their portfolio using
mechanical, automated methods.
What does eASCTrend 6.0 EODS do?
In short, the software provides traders

with automatic buy and sell signals
based on either proprietary trading systems or common indicators and oscillators like moving averages, stochastics,
relative strength index (RSI), moving
average convergence/divergence
(MACD), and more. More than this,
EODS features alerts, stops, back-testing, money management, and risk evaluation tools so that an EODS trader is
actually in as much control of the trade
as the average discretionary trader might
be. While geared toward helping traders make the most of trending markets
by avoiding sloppy, sideways markets,
eASCTrend 6.0 EODS still gives traders
enough flexibility so they feel in charge
without having to make every single
buy, sell, or exit decision as they arrive.
That said, it is also important to note
that eASCTrend 6.0 EODS is remarkably straightforward to operate. One of
the raps on automated/mechanical trading systems has been that running the
software was no less complex than was
creating and running your own trading
system. For these critics, the whole
“simplicity premium” of using an automatic trading system was lost if the
system was overly complex and as timeconsuming (and brain-twisting) as running a discretionary system or method
would be.
Fortunately, those who come to know
eASCTrend 6.0 EODS will find in it an
intuitive, well-organized system that,
while scalable to numerous positions
running numerous different trading/indicator packages, is still usable for the
individual retail trader looking to trade
a few mutual funds or a handful of
stocks as well.

LAY OF THE LAND
The eASCTrend 6.0 EODS platform can
be divided into as many as eight different workspaces, and each workspace
can be filled with a variety of chart,
alert, quote, or scan window. To get
started in the end-of-day version, all a
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FIGURE 1: STOCK ANALYSIS. Select the stock for analysis with the “Format Active Symbol
Window.” Set charting style, data range, and periodicity here.

FIGURE 2: THE WORKSPACE. Color-coded charts let eASCTrend traders see where entries and
exits are, as well as stop-loss levels and general trend up/down analysis.

trader needs to do is go to FILE, click for
“New Window” and then select “Chart
Window.” An “Insert Symbol” (Figure
1) window will pop up. Here, the trader
will enter the symbol of the stock he or
she is interested in, as well as make
other modifications such as chart style
(bars, candlesticks, line on close), the
date range of price data to be included
(available also as “days back”), and
the periodicity (from as short as ticks
and minutes to as long as weeks and
months). Click “OK” and the desired
chart, modifications intact, will appear
in the open workspace.
The topmost toolbar (Figure 2): File,
View, Insert, Format, Tools, Window,
Help. File contains the commands to
create and delete new windows, as well

as show the alert center and trade log.
Commands to open, close, save, delete,
or create new workspaces are here in the
File menu, as are data output/input and
printing options. View reveals or hides
both the lower toolbar and the status
bar. The lower toolbar contains hotkeys
for many of the functions—manipulating workspaces, changing periodicity,
zooming in/zooming out of the chart
and reducing/increasing the space between bars, and so forth, and the status
bar refers to system status and lets the
trader know that the system is receiving data (for the real-time version), as
well as signaling that the Internet connection is intact.
The Insert menu provides access to
both the insert symbol and insert analy-

sis pop-up windows. This menu also
has the “Insert Portfolio Data List” so
that larger numbers of stocks can be
added easily at once. The Format menu
allows traders to make basic changes to
the appearance of the stock, indicators,
and/or the chart itself. This is also another way for the trader to change aspects of the trading signal by way of the
“TradeSignal” option, which brings up
a “Set Global Trade Signal Formulas”
window. This window presents an array
of parameters that can be changed or
modified, as well as exit rules, plot style
for the actual signals themselves, and
settings for the autoscan feature.
The Tools menu option gives access
to the info window, which lets the trader
see the characteristics (high, low, open,
close, time, bid/ask, volume, change,
and bar number). There are also links to
toggle the status line, to set up and run
the Autoscan, change the password, reset the tick server, and refresh all or the
current charts. The lower toolbar—the
one that can be toggled on and off by
way of the option in the View menu—is
really just a collection of hot keys.
These functions include options to
open and close workspaces, print,
change periodicity, call up the info window, modify symbols and set-up analysis and trading rules and signals, change
bar spacing, set a music alert, run
Autoscan, display the trade signals report, and a few other tasks that are worth
having immediately at hand. eASCTrend
traders can also call up the money management calculator from a button on
this toolbar.

ENABLING EODS
eASCTrend 6.0 EODS comes with a helpful QuickStart guide to get traders up
and running with the software as quickly
and surely as possible. One of the tricks
with a mechanical trading program is to
avoid being overwhelmed by the array
of options and configuration possibilities. And one of the best ways to avoid
this is by focusing in on the basic functions of the software. In other words,
find a stock, set some parameters for
buy and sell signals (or stick with the
default parameters) and see what sort of
results you get. In this scenario, incre-

Reprinted from Technical Analysis of STOCKS

& COMMODITIES magazine. © 2004 Technical Analysis Inc., (800) 832-4642, http://www.traders.com

PRODUCT REVIEW

mental tweaking and “slow learning”
the software will probably be more
helpful in the long run than trying to
master the program whole.
For example, after calling up a symbol and charting it, an eASCTrend trader
may elect to use the default parameters
available in the “Format Trade Signal
for Active Chart” (Figure 3) or, by
pressing the dollar sign key next to the
“Scan TSPC” (which stands for “trade
signal performance control”) button,
which will cause the software to automatically determine which parameters
will yield the most profitable results
based on the specific active chart.
While this process can take up to 30
minutes with older, slower computers,
it is a valuable way of learning how
eASCTrend spots trading opportunities.
When the Scan TSPC process is complete, the eASCTrend trader will be able
to read a summary of the performance
of the system under the new parameters
(as opposed to the default parameters)
specially chosen for that chart.
The information provided in this summary is fairly extensive: total profit
long and short, a comparison with buy/
hold profit, total number of trades during the survey period, maximum drawdown, total trades long and short, total
win rate long and short and profit factor
for both long and short trades.
eASCTrend uses 11 different parameters—from TSPC to MONYRISK (which
helps define the tightness of protective
stops) and DEVIATION (another stoploss adjustment) to “Nth Bar” (exit
rules) and ProfitLevel (which signifies the point at which break-even and
trailing stops are deployed). Again,
the default values for many of these
parameters (such as ContractSize,
PointValues, and CostPerTrade) will
likely suffice for most traders most of
the time. However, the ability to change
and modify them is key to the system’s
flexibility and broad applicability to
tradables of all kinds in a variety of
trading environments.

ALL ABOUT ABLESYS
AbleSys is responsible for the mechanical/automated trading system that
STOCKS & COMMODITIES readers have

FIGURE 3: CONFIGURING SIGNALS. A great deal of specificity and flexibility in configuring trading
signals is possible through eASCTrend 6.0 EODS. This includes the option to let the system optimize
trading signals based on the chart being considered.

FIGURE 4: AUTOSCAN. eASCTrend 6.0 EODS’ Autoscan feature lets traders apply the eASCTrend
system to a variety of stocks—such as the components of the Dow Jones industrials—over a given
period. Scan results include profit, maximum drawdown, win rate, and other important trade
information.
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most celebrated over the years in our
Readers’ Choice Awards. And a quick
review of eASCTrend 6.0 EODS helps
explain why. While capable of a great
deal of trading signal complexity,
eASCTrend 6.0 EODS is accessible for
the average retail trader who simply is
looking for reliable buy and sell signals for trading stocks on an end-ofday basis. In addition to two different
paper-trading modes for those preferring to sample the software’s trading
system before committing actual capital to it, eASCTrend 6.0 EODS also
sports a helpful AutoScan (Figure 4)
feature that lets traders see the work of
the trading systems on a variety of
likely-to-be-traded stocks.
The AutoScan lets the eASCTrend
trader enter in a list of stocks, set trading
parameters (or, again, accept the default), and then let eASCTrend find the
entries and exits. Two keys in the lower
toolbar make it easy to switch back and
forth between items (shown as color
charts in the open workspace) in the
AutoScan list, and an Optimized TSPC
Autoscan Mini Report that provides a
summary of trading data (total profit,
maximum drawdown, total trades, winning rate, and so forth).
Those who have used eASCTrend 6.0
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EODS from anywhere from eight or nine
months to more than three years consistently express confidence in the
software’s trading signals. The risk control aspects of the software particularly
impressed a number of traders who highlighted the various stop-loss types available with AbleSys. Other traders opined
that the inclusion of mutual funds was a
significant plus for the software, while
still others said they appreciated the
way that eASCTrend 6.0 EODS graphically displayed not only its entry and
exit signals, but also support and resistance levels, helping warn traders when
stocks (or mutual funds or commodities, in other instances) were approaching “dangerous” levels.
In fact, AbleSys was so helpful in this
regard, according to one trader, that he
was able to use the software not just for
generating trading signals, but also as a
confirmation tool for his other trading
systems and methods. Technical support services for AbleSys also came in
for commendation, with “excellent” and
“very responsive” being typical, consensus praise.
Mechanical/automated trading systems are not for all traders. And even
some traders who do use such systems
only run a portion of their trading capi-

tal with mechanical or automated systems. As I alluded to at the outset, the
reasons for this vary from a simple lack
of trust in the idea of mechanical systems to a preference among some traders to remain as “hands-on” while trading as possible.
Nevertheless, there is a broad swath
of people for whom trading is less about
who they are and more about what they
do with their money. And if an automatic trading system can provide them
with positive results and winning trades,
they suffer no blow to the ego in the
process. As one trader I spoke with
stated bluntly when asked about his
experience—and level of satisfaction—
with the software, “I follow it blindly.”
And if you’re thinking about exploring the world of mechanical/automated
trading, then it’s hard to think of a more
simple, straightforward, and worthwhile
endorsement than that.
Technical Writer David Penn can be
reached at DPenn@Traders.com.
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